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[bookmark: _Toc118964997]Disclaimer
This technical documentation has been prepared by Her Majesty the Queen in right of Ontario as represented by the Ministry of Natural Resources and Forestry (the “Ministry”). No warranties or representations, express or implied, statutory or otherwise shall apply or are being made by the Ministry with respect to the documentation, its accuracy or its completeness. In no event will the Ministry be liable or responsible for any lost profits, loss of revenue or earnings, claims by third parties or for any economic, indirect, special, incidental, consequential or exemplary damage resulting from any errors, inaccuracies or omissions in this documentation; and in no event will the Ministry’s liability for any such errors, inaccuracies or omissions on any particular claim, proceeding or action, exceed the actual consideration paid by the claimant involved to the Ministry for the materials to which this instructional documentation relates. Save and except for the liability expressly provided for above, the Ministry shall have no obligation, duty or liability whatsoever in contract, tort or otherwise, including any liability or negligence. The limitations, exclusions and disclaimers expressed above shall apply irrespective of the nature of any cause of action, demand or action, including but not limited to breach of contract, negligence, strict liability, tort or any other legal theory, and shall survive any fundamental breach or breaches.
Cette publication spécialisée n’est disponible qu’en anglais.
[bookmark: _Toc118964998]Additional Information
This document does not comply with all the applicable guidelines for accessible digital documents. For an alternative format please email Land Information Ontario at geospatialsupport@ontario.ca.
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[bookmark: _Toc37097991][bookmark: _Toc118965001]List of Acronyms
API: Application Programming Interface
CHM: Canopy Height Model
COOP: Central Ontario Orthophotography Project
CRF: Cloud Raster Format
DRAPE: Digital Raster Acquisition Project Eastern Ontario
DSM: Digital Surface Model
DTM: Digital Terrain Model
FRI: Forest Resource Inventory
GIS: Geographic Information System
LERC: Limited Error Raster Compression
LIO: Land Information Ontario
LRC: Land and Resources Cluster
MNRF: Ontario Ministry of Natural Resources and Forestry
MRF: Meta Raster Format
NDVI: Normalized Difference Vegetation Index
NWOOP: Northwestern Ontario Orthophotography Project
OGC: Open Geospatial Consortium
OPS: Ontario Public Service
OWRS: Ontario Web Raster Services
REST: Representational State Transfer
SCOOP: South Central Ontario Orthophotography Project
SOAP: Simple Object Access Protocol
SWOOP: South Western Ontario Orthophotography Project
URL: Uniform Resource Locator
WCS: Web Coverage Service
XML: Extensible Markup Language
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[bookmark: _Toc118965002]Frequently Asked Questions
[bookmark: _Toc118965003]What are Ontario Web Raster Services and how do I access them?
Ontario Web Raster Services (OWRS) are a series of online services that provide access to seamless, project-wide imagery, elevation and landcover raster data for visualization, geoprocessing, and analysis. These services allow users to work with massive volumes of raster data on-demand, removing the need for: ordering, downloading, storing, pre-processing, or locally distributing versions of the data. 
The underlying infrastructure is managed and funded through partnership agreements between Land Information Ontario (LIO), the Land and Resources Cluster (LRC) and our business area partners. If you would like to publish your raster data as OWRS please contact Land Information Ontario for information on how to become a partner.
[bookmark: _Hlk115166895]OWRS use ArcGIS Image Server technology and are best accessed through a REST (Representational State Transfer) endpoint using the ArcGIS REST API. Most operations are typically best achieved by executing Raster Functions against a pre-defined area of interest. Please see the using Setting Geoprocessing Extents Raster Function “Clip” tutorial or additional support resources for more information. As with any new technology, there will be a learning curve, please be patient and don’t hesitate to provide feedback and seek support.


[bookmark: REST_endpoint][bookmark: _Toc118965004][bookmark: _Int_SSmE4lep]URL (Uniform Resource Locator) links to OWRS REST endpoint
REST endpoint: 
https://ws.geoservices.lrc.gov.on.ca/arcgis5/rest/services
For connection instructions, see tutorials: How do I connect and access Ontario Web Raster Services using the ArcGIS API and my local GIS? and How do I connect and access Ontario Web Raster Services using my local GIS and the OGC WCS standard?.
Open Geospatial Consortium (OGC) compliant Web Coverage Service (WCS) URLs are also available. WCS URLs can be accessed through the service REST endpoint or through the respective GeoHub Record. Please note, functionality and workflows are still being evaluated.


[bookmark: _What_is_the][bookmark: _Toc118965005]What is the REST endpoint and the ArcGIS REST API?
[bookmark: _Int_PEy4wha6]An Application Programming Interface (API) is used to standardize and facilitate communication between the client (you) and server hosting the data. They define what capabilities are available to the user through the service and are used to interpret all request and responses. APIs will commonly use either the SOAP or REST base communication standard, with REST being the more lightweight version using URLs to send or receive information. Ontario Web Raster Services use the ArcGIS REST API and offer most Image Service operations*. Clients will access the ArcGIS REST API through a URL connection string i.e., the REST endpoint. Commonly, users will first click on the URL- above, this will display a list of all folders (service groupings) and services offered under the REST endpoint. Each will then provide a list of service parameters and its supported functionality. Users can submit service requests (view, process, download, etc.) directly to the server (see ArcGIS REST API and ArcGIS API for Python). However, more commonly, users will setup a new ArcGIS Server connection within their favourite GIS (Geographic Information System) and rely on it to automatically create and submit requests while they work with the data. By using an ArcGIS Server connection, their GIS client software is being told to use the ArcGIS REST API.
*Please contact Land Information Ontario to discuss required, but unsupported functionality. 


[bookmark: _What_data_is][bookmark: _Toc118965006]What data is provided as an Ontario Web Raster Service?
The publicly available data includes authoritative elevation and land cover data from the Ontario Elevation Mapping Program, and the Forest Resources Inventory Unit. The following datasets are included:
Ontario Elevation Mapping Program Services 
Ontario Digital Terrain Model (Lidar-Derived)
Ontario Digital Surface Model (Lidar-Derived)
Ontario Digital Elevation Model (Imagery-Derived)
Ontario Digital Surface Model (Imagery-Derived)
Provincial Digital Elevation Model

Forest Resource Inventory Unit Services 
Forest Resource Inventory (FRI) 2007-2011 Orthophotography
FRI imagery is JPEG compressed at 80% quality and is not suitable for certain types of analytics
Available Forest Resource Inventory Term 2 (T2) 2018-2028 Orthophotography and Elevation raster derivatives (CHM, DTM, DSM)
Ontario Landcover Compilation V.2.0 
Changes to services and service offerings will be communicated through LIO emails, respective metadata records on GeoHub and updates to this document.
Note, the Ontario Imagery Data Service (OIDS) is provided by the Land Information Ontario Imagery Program and is only available to Land Information Ontario Member Ministries. 


[bookmark: _Toc118965007]How are the services hosted and what data formats are used?
All services are hosted from secured Microsoft Azure Cloud infrastructure (e.g., virtual servers, SQL databases, blob storage containers, etc.). One or many Mosaic Datasets underly each service. Each mosaic is comprised of cloud optimized data, including the underlying data, as well as, the pyramids and overviews used to access the data at smaller scales. The Meta Raster Format (MRF) is used to index and quickly stream data, while Limited Error Raster Compression (LERC) provides fast, lossless encoding and decoding. Raster Proxies are embedded in the mosaic and used as pointers to the optimized MRF / LERC source data in the cloud. Overviews in all services are converted into Cloud Raster Format (CRF). Performance of both the overviews and optimized source data is then further maximized through server-side caching. 
User implications:
When downloading or exporting from services it is important to convert the cloud optimized data into a recognizable and preferred user format. 
When a source tile or overview is first requested, the server pulls it from cloud storage and a cached copy is created on the server. As a result, initial requests can be slow, but subsequent requests will access the cached copy to improve performance.
Network optimized Raster Functions are recommended for all processing.
Service restrictions:
1. Raster Analytics has not been configured for Ontario Web Raster Services, thus some functionality is not currently supported.
Of the supported ArcGIS Image Server capabilities, 2 are not enabled for Ontario Web Raster Services:
0.3. Edit - Allows clients to add, update, or delete rasters from a mosaic dataset.
0.4. Uploads - Allows clients to upload raster files.
Request limits have been imposed on all services by default to prevent inefficient client requests and high bandwidth usage. These limits vary by service. Please refer to the View service supported operations and request limits section to learn how to check each service’s limits.
Each service may support or restrict different functionality as directed by the data owner. To view service parameters and / or understand available operations and data request limits, please see the respective REST endpoint (see tutorial). 
Key parameters include Spatial Reference, Pixel Size (X,Y), Band Count, Pixel Type, Raster Functions, Mensuration, Max values, Max Image (Heigh, Width), and Max Downloaded Image Count.
Esri known bug: The Download Rasters contextual menu tool accessed through the REST API, the table of contents and ribbon is non-functional. As a workaround we recommend using the Data Management, Download Rasters tool instead.
Please contact Land Information Ontario to discuss required, but unsupported functionality.


[bookmark: _Toc118965008]What are the main client benefits of Ontario Web Raster Services vs. existing web map services?
Provides near instant access to large collections of high-quality elevation and landcover raw data for both desktop-based and server-based custom workflows like change detection and feature extraction.
Clients no longer need to invest in local storage and data distribution media to support working with large volumes of lossy JPEG compressed raster data.
Services can be published or updated with authoritative data more frequently.
[bookmark: _Int_tkIz6Qzj]Allows users to open mosaic dataset tables, query the underlying raster data, understand its vintage, and confidently integrate the data within their workflows.
Clients can download source data in on-demand formats directly through services. No need to submit small data orders to LIO Support prior to field work.
Supports transposed, multidimensional data formats (i.e., data cubes and NetCDF) for easing time-series image navigation and processing.
Enables authoritative mensuration and metadata viewing within the service.
Provides access to cloud server computational resources for time-series or provincial scale analytical workflows. Contact LIO for more information.
Supports attaching unique images to feature points within a service, displayed as a popup to assist field level interpretation. Contact LIO for more information.
Custom or frequent processing requests (e.g., hillshade, slope, etc.) can be built into server-side processing templates for quick creation and access.
[bookmark: _Hlk115180042]Workflows can be easily shared with partners to support collaboration. 
[bookmark: _What_resources_are]

[bookmark: _What_resources_are_1][bookmark: _Toc118965009]What resources are available to me for additional support?
Available resources:
Land Information Ontario (LIO) support officers are available to help.
Online reading:
ArcGIS Image Server: What is ArcGIS Image Server?
ArcGIS Server: Key Concepts for Image Services
ArcGIS Pro: Raster Functions
YouTube: Raster Chain Function
ArcGIS REST APIs: Getting Started
ArcGIS REST APIs: Image Service
ArcGIS REST APIs: Getting Started with the Raster Analysis service
ArcGIS API for Python: Using the API
Imagery Workflows: Work with image services in ArcGIS Pro
Get started with raster functions in ArcGIS Pro
Esri blog post: Raster functions
ArcGIS Pro: List of raster functions
ArcGIS Online: Raster functions
GitHub: Esri ArcGIS Raster Functions
Esri: Managing Imagery Using Mosaic Datasets and Image Services
ArcGIS Pro: Multidimensional raster data
How to Make a 3D Diorama in ArcGIS Pro
How To: Estimate and build histograms for large raster dataset in ArcMap


[bookmark: LIO_Contact][bookmark: _How_can_I][bookmark: _Toc118965010]How can I provide feedback to the Ontario Web Raster Services team?
Contact LIO Support
Contact Land Information Ontario for support by email at lio@ontario.ca.  
For telephone, you can contact 705-772-5891.
You can also mail Land Information Ontario support at:
LIO Support
Land Information Ontario
Ministry of Natural Resources and Forestry
2nd Floor, North Tower
300 Water St
PO Box 7000
Peterborough, ON K9J 8M5



[bookmark: _Toc118965011]Terms of Use

By using Ontario Web Raster Services, you become a Licensee and hereby acknowledge that you have read the Ontario Open Government Licence, understand it and agree to be bound by its Terms and Conditions.



[bookmark: _Toc118965012]Tutorials
[bookmark: _Toc118965013]General Usage Considerations
Ontario Web Raster Services (OWRS) are designed to simulate and surpass the experience of working with local raster data. Each service provides thousands of individual tiles and millions, or even billions of pixels to users through an online connection. Common workflows such as clipping, exporting and band arithmetic calculations can be performed. However, there are some general points about the services which must be considered:
[bookmark: _Hlk115181737]OWRS impose pixel request restrictions to prevent server overload by inefficient requests. Geoprocessing tools are not designed for network processing, they will often submit requests which surpass limits and fail. Some tools won’t hit this limit, but still fail due to inefficient requests. Geoprocessing tools also write data locally which means processing is often slower and users must have the local resources to manage associated large data volumes.
[bookmark: _Hlk115181874]Raster Functions offer a network optimized processing alternative to geoprocessing tools which in practice, are not subject to pixel request restrictions and execute much faster. Raster Functions are essentially just processing instructions to be executed against pixels as they arrive at your GIS. These instructions can be chained together to execute custom analyses. The result is often a new service layer found in the table of contents. However, these layers often cannot be used in geoprocessing tools because their generated from on-the-fly processing, there is no local data to use as an input. A Raster Function service layer would need to be written to hard disk first. Instead, users are encouraged to create and share Raster Function Chains rather than exported derivatives. This prevents the need for duplicated and costly local storage. 
[bookmark: _Hlk115182115]If you are forced to use Geoprocessing tools because the functionality is not supported by Raster Functions, be sure to segment your workflow into smaller areas  (see Setting Geoprocessing Extents: see Method 2) then merge the results. By default, geoprocessing tools will execute against the whole service. 
Raster Functions will only execute against the pixels in your view by default; however, we suggest isolating your workflow to just your area of interest to improve sharing and processing speeds (“Setting Geoprocessing Extents: see Method 1”),
Although the services and data are optimized for low bandwidth networks, local network speeds can still impact service performance. 
OWRS are primarily designed to be a raster data processing solution, not a data distribution tool. Download Raster and Export Raster requests are limited on all services. However, local caching and limited download/exports are available to support offline work requirements.
Please contact LIO Support or the data owner for large data download requests.
By default, some GIS software will apply a stretched render to the data which is usually detrimental to optimized viewing. Follow standard symbology management workflows to remove this render if required. For imagery, set the stretch to “None”. When loading some of the elevation services their initial appearance maybe monotone because the software struggles to read 32-bit raster service statistics. To correct this issue, open the service symbology, apply a standard deviation stretch and then set the symbology to minimum-maximum.
[bookmark: _Toc118965014]Tutorial Software Versions
The following software versions were used to prepare the tutorials and are recommended to users:
ArcGIS Desktop 10.8.1
ArcGIS Pro 2.9.3
QGIS 3.24.1

Return to Table of Contents.



[bookmark: _How_do_I][bookmark: _How_do_I_2][bookmark: _How_do_I_4][bookmark: _How_do_I_6][bookmark: _Toc118965015][bookmark: ConnectWithArcGISAPI]How do I connect and access Ontario Web Raster Services using the ArcGIS API and my local GIS?

Using ArcGIS Desktop
1. Open ArcCatalog (or use the ArcCatalog window in ArcMap). Expand the “GIS Servers” folder and double click “Add ArcGIS Server”.

[image: Image showing how to create a new ArcGIS Server Connection in ArcGIS Desktop]
[bookmark: _Toc108094572][bookmark: _Toc110868456]Figure 1: Create a new ArcGIS Server Connection with ArcGIS Desktop.
Select “Use GIS Services”. 
1.3. For the Server URL, enter the REST endpoint URL. 
Authentication is not required, click “Finish”. 
[image: Image showing how to connect to an ArcGIS Server in ArcGIS Desktop]
[bookmark: _Toc108094573][bookmark: _Toc110868457]Figure 2: Connect to the ArcGIS Server with ArcGIS Desktop.
Using ArcGIS Pro
1. Insert tab, Connections, New ArcGIS Server.
[image: Image showing how to create a new ArcGIS Server Connection in ArcGIS Pro]
[bookmark: _Toc108094574][bookmark: _Toc110868458]Figure 3: Create a new ArcGIS Server Connection with ArcGIS Pro.
1. For the Server URL, enter the REST endpoint URL.
[image: Image showing how to connect to an ArcGIS Server in ArcGIS Pro]
[bookmark: _Toc108094575][bookmark: _Toc110868459]Figure 4: Connect to the ArcGIS Server with ArcGIS Pro
Using ArcGIS Online Classic Viewer
1. Expand the “Add” drop down menu and select “Add Layer from Web”
[image: ]

Figure 5: Add Layer from Web in ArcGIS Online
1. For the URL, enter the REST endpoint URL for the service you wish to add. Select ADD LAYER
NOTE: You can only add one service at a time.
[image: ]
Figure 6: Connect to ArcGIS Server with ArcGIS Online
Using QGIS
ArcGIS Image Server services do not work properly in QGIS when connecting with the ArcGIS REST API. Please connect to the services using the OGC WCS standard if using QGIS. 
Return to Table of Contents.




[bookmark: _How_do_I_1][bookmark: _How_do_I_3][bookmark: _How_do_I_5][bookmark: _How_do_I_7][bookmark: _Toc118965016][bookmark: ConnectWithWCS]How do I connect and access Ontario Web Raster Services using my local GIS and the OGC WCS standard?
Using ArcGIS Desktop
ArcGIS Image Server services do not work properly in ArcMap when connecting with a WCS. Please connect to the services using the ArcGIS API if using ArcMap.
Using ArcGIS Pro
ArcGIS Image Server services do not work properly in ArcGIS Pro when connecting with a WCS. Please connect to the services using the ArcGIS API if using ArcGIS Pro. 
Using QGIS
1. Locate the service specific WCS URL connection string. Click on either the OPS internal or public facing REST endpoint (URL) to open the OWRS ArcGIS REST Services Directory. 
Navigate the folder structure to locate and open the service parameter listing (image below). 
Click on WCS in the top left corner to open the WCS XML capabilities file. The WCS connection string (URL) will be listed in the address bar and in the XML file.


[image: An image showing how to retrieve an ArcGIS Server service's WCS url.]
[bookmark: _Toc108094576][bookmark: _Toc110868460]Figure 7: Retrieve the service's WCS URL.
Open the “Data Source Manager”. Right click “WCS” and create a new connection. 
[image: Image showing how to create a WCS connection in QGIS]
[bookmark: _Toc108094577][bookmark: _Toc110868461]Figure 8: Create a new WCS Connection with QGIS.

Add a desired connection name and the WCS URL.
[image: Image showing how to connect to a WCS in QGIS]
[bookmark: _Toc108094578][bookmark: _Toc110868462]Figure 9: Connect to the WCS Server with QGIS.
Right click the layer in the browser window and select, “Add Layer to Project”. 
[image: An Image showing how to add a WCS layer to QGIS.]
[bookmark: _Toc110868463]Figure 10: Add a WCS Layer to QGIS
The appearance of the layer can be improved by making the black background transparent. To do this, right click the layer in the table of contents and select, “Properties…”. Select the “Transparency” tab, set the “Additional no data value” to 0 and click OK.
[image: An image showing how to set the transparency of a WCS layer.]
[bookmark: _Toc110868464]Figure 11: Remove the black background from the WCS Layer
[bookmark: _￼View_service_supported][bookmark: ViewServiceSupportedOperations][bookmark: _Toc118965017]
View service supported operations and request limits
1. Click on either the OPS internal or public facing REST endpoint (URL) to open the OWRS ArcGIS REST Services Directory.
Navigate to the desired service by clicking the appropriate “Folder” link followed by the “Service” link.
[image: ]
[bookmark: _Toc108094579][bookmark: _Toc110868465]Figure 12: Navigate to a service's REST endpoint.
Scroll down the page to find the max image size (in pixels) and max number of tiles that can be downloaded by a single request. Geoprocessing operations that are supported by the service are visible at the bottom of the page in the “Supported Operations” section.
[image: Image showing how to view an ArcGIS Server service's request limits and supported operations.]
[bookmark: _Toc108094580][bookmark: _Toc110868466][bookmark: _Hlk107954083]Figure 13: View a services request limits and supported operations.
Return to Table of Contents.



[bookmark: _Toc118965018]Using Pre-Defined Processing Templates
Server-side processing templates have been created and are available for most OWRS. These processing templates allow users fast access to common derivative data products (e.g., elevation hillshades, calculated band indices) without having to process the data in their local GIS. The following server-side processing templates are currently available:
Orthophotography: NDVI, NDVI Scientific, NDVI Colourized
Provincial Digital Elevation Model: Aspect, Contour, Hillshade, Multidirectional Hillshade, Multidirectional Shaded Relief, Shaded Relief, Slope
FRI Single Photon Lidar DTM: Slope, Aspect, Shaded Relief
Using ArcGIS Desktop
1. Add the desired dataset to a map document and open the layer properties.
[bookmark: _Toc108094581][image: ]
[bookmark: _Toc110868467]Figure 14: Open the layer properties in ArcMap.
Select the “Processing Templates” tab and pick the desired template from the “Function” dropdown menu. Click OK.
[image: Image showing how to select a processing template function in ArcGIS Desktop]
[bookmark: _Toc108094582][bookmark: _Toc110868468]Figure 15: Select a function from the Processing Templates in ArcMap.
Using ArcGIS Pro
1. Add the desired dataset to a map document. Highlight the dataset in the table of contents and click the “Data” tab on the menu ribbon. Select the “Processing Templates” drop down button and select a template.
[bookmark: _Toc108094583][image: ]
[bookmark: _Toc110868469]Figure 16: Select a function from the Processing Templates in ArcGIS Pro.
Using ArcGIS Online
1. Add the desired dataset to your map frame. Select the ellipses for “More Options” and select “Image Display.
[image: ]
Figure 17: Select Image Display in More Options
Under the Renderer drop down menu, select from the Processing Template Options.
[image: ]
Figure 18: Selecting from Processing Templates
Using QGIS
The pre-defined image processing templates do not work consistently in QGIS. It is recommended that the user manually creates any required derivatives by using the various raster tools in QGIS. Please refer to the QGIS portion of the “Performing Raster Calculations” section for support.

Return to Table of Contents.



[bookmark: _Setting_Geoprocessing_Extents][bookmark: _Toc118965019][bookmark: SettingGeoprocessingExtents]Setting Geoprocessing Extents
There are multiple methods that could be used to ensure that geoprocessing tasks occur within defined extents. The following section outlines two possible methods of completing this task in ArcGIS Desktop, ArcGIS Pro and QGIS. 
Method 1 (Recommended) – Raster Function: Clip
Raster Function “Clip” will create a new area-of-interest service layer in the table of contents which can be used for subsequent analysis. This layer is being processed on-the-fly using instructions found in local temporary storage. There are three key processing implications of building a workflow using this tool:
1. Standard geoprocessing tools cannot ingest the layers. If these are needed see Method 2.
1. On-the-fly processing can be expanded using Raster Function chains.
1. On-the-fly processing means that pixel requests are more efficient, providing a work-around for request limits.
Using ArcGIS Desktop
1. Add the desired dataset to a map document and open the “Image Analysis” window.
[image: Image showing how to open the image analysis pane in ArcGIS Desktop]
[bookmark: _Toc108094584][bookmark: _Toc110868470]Figure 19: Open the Image Analysis pane in ArcMap.
1. The Image Analysis Clip tool uses the map document’s view extent as the clip extent by default. Zoom the map document to the desired extent, select the raster layer in the table of contents and click the Clip tool in the Processing pane of the Image Analysis window.
[image: Image showing how to use the image analysis clip tool in ArcMap.]
[bookmark: _Toc108094585][bookmark: _Toc110868471]Figure 20: Run the Image Analysis Clip tool in ArcMap
A new service layer will be added to the map document based on the clipping extent.
[image: Image showing an example of a clipped raster.]
[bookmark: _Toc108094586][bookmark: _Toc110868472]Figure 21: Example of the Clip Raster Function creating a Raster Function service layer from a large area of interest. All subsequent Raster Functions can then be executed against this layer and its extent.
Using ArcGIS Pro
1. On the ribbon, click the “Imagery” tab then the “Raster Functions” button.
[image: Image showing how to display the available raster functions in ArcGIS Pro.]
[bookmark: _Toc108094587][bookmark: _Toc110868473]Figure 22: Display available raster functions, by selecting the Imagery tab and Raster Functions button.
Within the table of available Raster Functions, select “Data Management”, then “Clip”.
Under “Raster” input the service from the dropdown menu, define your desired “Clipping Type”, and for the “Clipping Geometry / Raster” input a shapefile, feature class, extent coordinates or the default “<Active-Map-View-Extent>”.

[image: Graphical user interface, application

Description automatically generated] 
[bookmark: _Toc108094588][bookmark: _Toc110868474]Figure 23: Access and parametrize the Raster Functions, Data Management, Clip tool.


[image: An image showing the results of the clip raster function tool in ArcGIS Pro.]
[bookmark: _Toc108094589][bookmark: _Toc110868475]Figure 24: Example of the Clip Raster Function creating a new Raster Function service layer from a large area of interest. All subsequent Raster Functions can then be executed against this layer and its extent.

Using QGIS
Raster Functions require the ArcGIS REST API. ArcGIS Image Server services do not work properly in QGIS when connecting with the ArcGIS REST API. Please connect to the services using the OGC WCS standard and see the Raster Calculator QGIS tutorial for instructions on how to constrain processing extents.
Method 2 – Environment Settings
Given an area of interest, your Geoprocessing Environment Settings can be used to define and restrict processing extents. This will make processing more eff
Using ArcGIS Desktop
1. Click the “Geoprocessing” drop down menu and select the “Environments…” button.
[image: ]
[bookmark: _Toc108094590][bookmark: _Toc110868476]Figure 25: Open the Environments window in ArcMap.
Set the top, bottom, left and right extent values in the Processing Extent section. Inputs should match the current map document coordinate system. After clicking “Ok”, all subsequent geoprocessing tasks run in this ArcMap session will only execute within your defined extents.

[image: Image showing how to set the geoprocessing extent in ArcMap.]
[bookmark: _Toc108094591][bookmark: _Toc110868477]Figure 26: Set the processing extent in ArcMap.
Using ArcGIS Pro
1. Select the “Analysis” tab on the ribbon and click the “Environments” button.
[bookmark: _Toc108094592][image: ]
[bookmark: _Toc110868478]Figure 27: Open the Environments window in ArcGIS Pro.
Set the top, bottom, left and right extent values in the processing extent section. Inputs should match the current map document coordinate system. After clicking “Ok”, all subsequent geoprocessing tasks run in this ArcGIS Pro session will only execute within your defined extents. 
[image: Image showing how to set the geoprocessing extent in ArcGIS Pro.]
[bookmark: _Toc108094593][bookmark: _Toc110868479]Figure 28: Set the processing extent in ArcGIS Pro.
Using QGIS
QGIS does not have application wide, processing extent settings that can be defined. However, processing extents can be set when each tool is run. See the Raster Calculator QGIS tutorial for instructions on how to constrain processing extents.
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[bookmark: Raster_Calculations][bookmark: _Toc118965020]Performing Raster Calculations
This tutorial shows the reader how to perform raster calculations using Raster functions. Raster Functions are the primary resource available to users and can support most workflows. This tutorial is provided for reference only. Users are advised to create a new Raster Function service layer for their area of interest before executing Raster Functions. (For Raster Function workflows, see Setting Geoprocessing Extents: Method 1 Raster Function - Clip. For Geoprocessing workflows, see Setting Geoprocessing Extents: Method 2 Environment Settings).
Using ArcGIS Desktop
1. Add the desired dataset to a map document and open the “Image Analysis” window.
[image: Image showing how to open the image analysis pane in ArcGIS Desktop]
[bookmark: _Toc108094594][bookmark: _Toc110868480]Figure 29: Open the Image Analysis pane in ArcMap.
Open the function template editor in the Processing pane of the Image Analysis window.
[image: Image showing how to open the function template editor in ArcGIS Desktop]
[bookmark: _Toc108094595][bookmark: _Toc110868481]Figure 30: Open the function template editor in ArcMap.
Right click the Identify function, highlight insert function and select the function you’d like to use. Custom Band Arithmetic can be completed with the Band Arithmetic function.
[image: Image showing how to create a band arithmetic function in ArcGIS Desktop]
[bookmark: _Toc108094596][bookmark: _Toc110868482]Figure 31: Insert a band arithmetic function.
Click the “Method” drop down menu and select one of the pre-defined methods or create your own using the “User Defined” option. Write the desired band arithmetic expression and click OK.
[image: Image showing how to define a band arithmetic raster function expression in ArcGIS Desktop]
[bookmark: _Toc108094597][bookmark: _Toc110868483]Figure 32: Define the raster function expression in ArcMap.
Using ArcGIS Pro
1. Add the desired dataset to a map document. Highlight the layer in the table of contents, click the “Imagery” tab on the menu ribbon and select the “Raster Functions” item.
[image: Image showing how to open the raster functions pane in ArcGIS Pro]
[bookmark: _Toc108094598][bookmark: _Toc110868484]Figure 33: Open the raster functions pane in ArcGIS Pro.
The “Raster Functions” pane will open. Select the “Band Arithmetic” function found in the “Math” category.
[image: Image showing how to open the band arithmetic function in ArcGIS Pro]
[bookmark: _Toc108094599][bookmark: _Toc110868485]Figure 34: Open the band arithmetic function in ArcGIS Pro.
Select the service using the “Raster” dropdown menu. Using the “Method” dropdown, select one of the pre-defined methods or create your own using the “User Defined” option. Write the desired band arithmetic expression and click “Create new layer”.

[image: Image showing how to define a band arithmetic raster function expression in ArcGIS Pro]
[bookmark: _Toc108094600][bookmark: _Toc110868486]Figure 35: Define the raster function expression in ArcGIS Pro.
Using QGIS
1. Add the desired dataset to the map document as a WCS. Select the “Raster” drop down menu and click the “Raster Calculator…” tool.
[image: Image showing how to open the raster calculator in QGIS]
[bookmark: _Toc108094601][bookmark: _Toc110868487]Figure 36: Open the raster calculator in QGIS.
Build the desired raster calculator expression using the available raster bands. Select the “Create on-the-fly raster instead of writing layer to disk” if you wish to view the result without saving the result. Click OK.
[image: Image showing how to define a raster calculator expression in QGIS]
[bookmark: _Toc108094602][bookmark: _Toc110868488]Figure 37: Define the raster calculator expression in QGIS.

[bookmark: ExportingData][bookmark: _Exporting_Data][bookmark: _Extracting_Data]
[bookmark: _Toc115963109][bookmark: _Toc118965021]Sharing Raster Function Chains
One of the benefits of image services is the ability to enable others to reproduce your analysis and/or visualization without the need to send them large quantities of data, map documents, scripts, etc. Once you have built a chain of raster functions as described in “Performing Raster Calculations” above, you can export it as a small file that you can share. The recipient need only apply it to the same web service to get the same results, or the function can be re-used on other compatible services.
Part 1 – Exporting Custom Functions
The following are instructions to export raster function templates from ArcMap and ArcGIS Pro. They both assume that you have followed the steps in [LINK TO PREVIOUS SECTION] to create a function chain that is ready for export.
Using ArcMap

1. Open the “Image Analysis” panel
23. In the “Image Analysis” panel, in the top section, select the function chain to be exported
[image: Image showing the selection of a raster function chain in the Image Analysis window.]
[bookmark: _Toc115963155]Figure 40. Selecting an image layer in the Image Analysis window
24. From the “Processing” section of the “Image Analysis” pane, click “Add Function”
[image: Image showing the location of the "Add Function" button in the image analysis window.]
[bookmark: _Toc115963156]Figure 41. Opening the function editor from the Image Analysis window
25. In the “Function Template Editor” window that appears, right-click on the item immediately below “Function Chain” in the hierarchy and click “Export as Template..”
[image: Image showing "Export As Template..." as the third option in the context menu.]
[bookmark: _Toc115963157]Figure 42. Activating the "Export As Template" dialog form the Function Template Editor.
26. A “Function Template Editor – Untitled” window will appear. From the “File” menu, click “Save”. 
[image: Image showing the position of the "Save" option ]
[bookmark: _Toc115963158]Figure 43. Saving function template to file from function template editor
27. Use the file dialog to save to a location of your choice

Using ArcGIS Pro

1. From the “Analysis” ribbon, click “Raster Functions”
[image: Image showing the location of the Raster Functions button on the Analysis ribbon.]
[bookmark: _Toc115963159]Figure 44. Activating the Raster Functions pane in ArcGIS Pro
29. In the “Raster Functions” pane, click “Custom”
30. Right-click on the function to be exported and click “Export”
[image: Image showing the location of the Export function in the context menu after right-clicking on the raster function to be exported.]
[bookmark: _Toc115963160]Figure 45. Initalizing export of custom raster function in ArcGIS Pro
31. Use the file dialog to save to a location of your choice
Part 2 – Using Custom Functions

These steps assume that a compatible image service has already been loaded into the map view in ArcMap or ArcGIS Pro.
Using ArcMap

1. Open the “Image Analysis” panel
33. In the “Image Analysis” panel, in the top section, select the image service layer to which the custom raster function will be applied
[image: Image showing the "Elevation\FRI_DTM_SPL" image service layer selected in the Image Analysis window.]
[bookmark: _Toc115963161]Figure 46. Selecting an image layer in the Image Analysis window.
34. From the “Processing” section of the “Image Analysis” pane, click “Apply Function”
[image: ]
[bookmark: _Toc115963162]Figure 47. Activating "Apply Function" from the Image Analysis window
35. Browse to the raster function template file to be applied and click “Open”
[image: Image showing the "Select Function Template" file dialog, with a function template selected.]
[bookmark: _Toc115963163]Figure 48. Selecting a raster function template to be applied from file.


Using ArcGIS Pro

36. From the “Analysis” ribbon, click “Raster Functions”
[image: Image showing the location of the Raster Functions button on the Analysis ribbon.]
[bookmark: _Toc115963164]Figure 49. Activating the Raster Function pane in ArcGIS Pro
37. In the “Raster Functions” pane, click “Custom”
38. Hover over the sub-section header where you would like the function to be imported (default is “Custom1”)
39. Click the “Import Function” button
[image: Image showing the location of the "Import Function" button in the Raster Functions pane.]
[bookmark: _Toc115963165]Figure 50. Activating raster function import in the Raster Functions window in ArcGIS Pro
40. Browse to the raster function template to be applied and click “OK”
[image: Image showing the "Select Processing Templates" window with a raster function named "Contour Colourized" selected.]
[bookmark: _Toc115963166]Figure 51. Selecting raster function template to be imported from file into ArcGIS Pro
41. The function will now appear in the Raster Functions window and can be applied to image services like any other
[image: Image showing the imported raster function template in the Raster Functions pane]
[bookmark: _Toc115963167]Figure 52. A custom raster function after import into ArcGIS Pro
Return to Table of Contents.



[bookmark: _Toc118965022]Exporting Data
OWRS impose a 20 tile download and 30,000 x 30,000 (rows x columns) pixels request limit by default. These restrictions are imposed given egress costs and are designed to prevent the service from becoming overloaded. If you receive errors while geoprocessing or exporting data, we suggest segmenting your workflow so that it doesn’t exceed these limits. Users may also reduce the requested resolution (Cell Size). Each service maybe parameterized differently, therefore it is recommended that users review the service parameter listing before segmentation. Large download requests (>20 tiles) can be addressed by SFTP services and/or manual clip, zip and ship services offered through LIO Support. 
Using ArcGIS Desktop
1. Add the desired dataset to a map document. Right click the layer in the table of contents and select “Data” -> “Export Data…”.
[image: Image showing how to open the export data window in ArcGIS Desktop]
[bookmark: _Toc108094603][bookmark: _Toc110868489]Figure 38: Open the export data window in ArcMap.
2. Set the output extent, coordinate system, cell size, file name and file format. Click Save. Before opening the “Export Rasters”, users may choose to zoom to the desired output extent, then open the tool and use the “Data Frame (Current)” option to automatically parameterize it. The Raster Size (columns, rows) field will display the number of pixels requested. This field can be manually adjusted to prevent exceeding the service request limits.
[image: Image showing how to complete the export image service data form in ArcGIS Desktop]
[bookmark: _Toc108094604][bookmark: _Toc110868490]Figure 39: Export the Ontario Web Raster Service data in ArcMap.
Using ArcGIS Pro
1. Add the desired dataset to a map document. Right click the layer in the table of contents and select “Data” -> “Export Raster”.
[image: Image showing how to open the export raster window in ArcGIS Pro]
[bookmark: _Toc108094605][bookmark: _Toc110868491]Figure 40: Open the export raster window in ArcGIS Pro.
Set the output extent, coordinate system, cell size, file name and file format. Click Save. Before opening the “Export Rasters”, users may choose to zoom to the desired output extent, then open the tool and use the “Data Frame (Current)” option to automatically parameterize it. The Raster Size (Columns, Rows) field will display the number of pixels requested. This field can be manually adjusted to prevent exceeding the service request limits.
[image: Image showing how to complete the export raster form in ArcGIS Pro]
[bookmark: _Toc108094606][bookmark: _Toc110868492]Figure 41: Export Ontario Web Raster Service data in ArcGIS Pro.
Using QGIS
1. Add the desired dataset to the map document as a WCS. Right click the layer in the table of contents and select, “Export” -> “Save As…”
[image: Image showing how to open the save raster layer window in QGIS]
[bookmark: _Toc108094607][bookmark: _Toc110868493]Figure 42: Open the save raster layer window in QGIS.
Set the output file format, file name, coordinate system, extent and pixel resolution. Click OK. It is recommended that you zoom your map document to the desired output extent and use the “Map Canvas Extent” option to ensure that only the data you need to extract is downloaded. The Resolution (Columns, Rows) field will display the number of pixels requested. This field can be manually adjusted to prevent exceeding the service request limits.
[image: Image showing how to complete the save raster layer form in QGIS]
[bookmark: _Toc108094608][bookmark: _Toc110868494]Figure 43: Complete the save raster layer form in QGIS.
[bookmark: _￼Downloading_Data]Return to Table of Contents.
[bookmark: _Toc118965023]
Downloading Data
Some services allow for downloading tile selections. Please refer to the “View service supported operations and requests limits” section to see if the “Download” capability has been enabled for the service and to determine the max number of tiles that can be downloaded with a single request. Esri known bug: The Download Rasters contextual menu tool accessed through the REST API, the table of contents and ribbon is non-functional. As a workaround we recommend using the Data Management, Download Rasters tool described here instead.
Using ArcGIS Desktop
1. Add the desired dataset to the map document. Open the “Search” window and find the “Download Rasters” tool in the “Data Management” toolbox. 
[image: Image showing how to open the download rasters tool in ArcMap.]
[bookmark: _Toc108094609][bookmark: _Toc110868495]Figure 44: Open the Download Rasters tool in ArcMap.
Complete the Download Rasters form. Ensure that the “Convert Rasters” option is enabled. Use an SQL selection expression or a selection feature layer to ensure that only the necessary raster tiles are downloaded. 
45.3. The SQL Query Builder tool used to help define a selection expression may not work properly due to an Esri bug. It may be necessary to use the service’s attribute table to help determine a valid SQL expression for selecting the required tiles. 
45.4. The number of tiles that can be downloaded by a single request will be limited. Please refer to the service’s parameter listing under the REST endpoint to determine the maximum number of tiles allowed (default is 20). 
[image: Image showing how to complete the download rasters tool parameters in ArcMap.]
[bookmark: _Toc108094610][bookmark: _Toc110868496]Figure 45: The Download Rasters tool in ArcMap.
Using ArcGIS Pro
1. Add the desired dataset to the map document. Select the “Analysis” ribbon tab and click the “Tools” button to open the geoprocessing tools window. Search for the “Download Rasters” tool and open it. 

[image: Image showing how to opne the download rasters tool in ArcGIS Pro.]
[bookmark: _Toc108094611][bookmark: _Toc110868497]Figure 46: Open the Download Rasters tool in ArcGIS Pro.
Complete the Download Rasters form. Ensure that the “Convert Rasters” option is enabled. Select your desired data format and compression. Use an SQL selection expression to ensure that only the necessary raster tiles are downloaded. Tip, use the “Category” field to distinguish between raw data “1 – Primary” and reduced resolution, large area overviews “2 – Overview”.
[bookmark: Extracting_Data_QGIS]The number of tiles that can be downloaded by a single request will be limited. Please refer to the service’s parameter listing under the REST endpoint to determine the maximum number of tiles allowed (default is 20). 
[image: Image showing how to complete the download rasters tool parameters in ArcGIS Pro.]
[bookmark: _Toc108094612][bookmark: _Toc110868498]Figure 47: The Download Rasters tool in ArcGIS Pro.
Return to Table of Contents.

Using QGIS
Downloading specific raster tiles is not possible in QGIS. Please refer to the Extracting Data section for steps outlining how to export data from the service in QGIS. 
[bookmark: _Toc118965024]Extract by Mask
OWRS impose a 20 tile download and 30,000 x 30,000 (rows x columns) pixels request limit by default. These restrictions are imposed given egress costs and are designed to prevent the service from becoming overloaded. If you receive errors while geoprocessing or extracting data, we suggest segmenting your workflow so that it doesn’t exceed these limits. Users may also reduce the requested resolution (Cell Size). Each service maybe parameterized differently, therefore it is recommended that users review the service parameter listing before segmentation. Large download requests (>20 tiles) can be addressed by SFTP services and/or manual clip, zip and ship services offered through LIO Support. 
Using ArcGIS Desktop
1. Open ArcMap and ensure that the Spatial Analyst extension is activated. 
[image: Image showing how to activate the spatial analyst extension in ArcMap.]
[bookmark: _Toc110868499]Figure 48: Activate the Spatial Analyst extension in ArcMap
Add the desired raster service and “mask” raster to a map document. 
Open the mask raster’s layer properties and click the “Source” tab. Ensure that the mask raster is in the NAD83 CSRS UTM zone projection appropriate for the study area. Use the “Project Raster” Data Management tool to project the mask raster to the appropriate NAD83 CSRS UTM zone if needed.
[image: Image showing how to check projection and project a raster in ArcMap.]
[bookmark: _Toc110868500]Figure 49: Check the mask raster's projection and project if necessary
Open the mask raster’s layer properties and click the “Source” tab. Ensure that the mask raster has the same cell size as the raster service. Use the “Resample” Data Management tool to change the mask raster’s cell size if needed.
[image: Image showing how to check a raster's cell size and change the cell size in ArcMap.]
[bookmark: _Toc110868501]Figure 50: Resample the mask raster's cell size if necessary
Open the “Extract by Mask” Spatial Analyst tool. Click the “Environments” button and set the cell size to be the same as the raster service (in Raster Analysis section), snap raster to the mask (in Processing Extent section) and output projection to be the same as the mask (in Output Coordinates section). Run the Extract by Mask tool.
[image: Image showing how to set raster environment settings and run the extract by mask tool in ArcMap.]
[bookmark: _Toc110868502]Figure 51: Set the raster environment settings and run the Extract by Mask tool
Using ArcGIS Pro
1. Open ArcGIS Pro and ensure that the Spatial Analyst extension is activated. 
[image: Image showing how to enable the spatial analyst extension in ArcGIS Pro.]
[bookmark: _Toc110868503]Figure 52: Activate the Spatial Analyst extension in ArcGIS Pro
Add the desired raster service and “mask” raster to a map document. 
Open the mask raster’s layer properties and click the “Source” tab. Ensure that the mask raster is in the NAD83 CSRS UTM zone projection appropriate for the study area. Use the “Project Raster” Data Management tool to project the mask raster to the appropriate NAD83 CSRS UTM zone if needed.
[image: Image showing how to check a raster's projection and change the projection in ArcGIS Pro.]
[bookmark: _Toc110868504]Figure 53: Check the mask raster's projection and project if necessary
Open the mask raster’s layer properties and click the “Source” tab. Ensure that the mask raster has the same cell size as the raster service. Use the “Resample” Data Management tool to change the mask raster’s cell size if needed.
[image: Image showing how to check a raster's cell size and change it in ArcGIS Pro.]
[bookmark: _Toc110868505]Figure 54: Resample the mask raster's cell size if necessary
Open the “Extract by Mask” Spatial Analyst tool. Click the “Environments” tab and set the cell size to be the same as the raster service (in Raster Analysis section), snap raster to the mask (in Processing Extent section) and output projection to be the same as the mask (in Output Coordinates section). Run the Extract by Mask tool.
[image: Image showing how to set raster environment settings and run the extract by mask tool in ArcGIS Pro.]
[bookmark: _Toc110868506]Figure 55: Set the raster environment settings and run the Extract by Mask tool
Using QGIS
1. Open QGIS and add the desired raster service as a WCS and “mask” raster to the document. 
Open the mask raster’s layer properties and click the “Source” tab. Ensure that the mask raster is in the NAD83 CSRS UTM zone projection appropriate for the study area. Use the Warp (Reproject) tool to project the mask raster to the appropriate NAD83 CSRS UTM zone if needed.
[image: Image showing how to check a raster's projection and reproject in QGIS.]
[bookmark: _Toc110868507]Figure 56: Check the mask raster's projection and reproject if necessary
Open the mask raster’s layer properties and click the “Information” tab. Ensure that the mask raster has the same cell size as the raster service. Use the Warp (Reproject) tool to change the mask raster’s cell size (and projection) if needed.
[image: Image showing how to check a raster's cell size and change it in QGIS.]
[bookmark: _Toc110868508]Figure 57: Resample the mask raster's cell size if necessary
Open the “Raster Calculator” tool. 
49.3. Write an expression to convert all pixel values in the mask raster to a value of “1” and multiply this by the raster service. An example expression is:
(maskLayer@1 >= 0) * rasterServiceLayer@1

49.4. To ensure the extents match the mask layer, in the raster calculator window select the mask layer in the 'Raster bands' list on the left and then click the 'Current layer extent' button on the right. Run the tool.
[image: Image showing how to use the Raster Calculator to extract a subset of a raster using a mask raster in QGIS.]
[bookmark: _Toc110868509]Figure 58: Extract the raster using the Raster Calculator in QGIS
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[bookmark: _Viewing_Tile_Metadata][bookmark: _Toc118965025]Viewing Tile Metadata
Using ArcGIS Desktop
1. Add the desired dataset to a map document. Right click the layer in the table of contents and select “Open Attribute Table”.
[image: Image showing how to open an attribute table in ArcGIS Desktop]
[bookmark: _Toc108094613][bookmark: _Toc110868510]Figure 59: Open an attribute table in ArcGIS Desktop.
The attribute table will open. Click inside the empty “Raster” column of a tile. Click the arrow on the right and the tile metadata window will appear.
[image: Image showing how to view a raster tile's metadata information in ArcGIS Desktop]
[bookmark: _Toc108094614][bookmark: _Toc110868511]Figure 60: View a tile's metadata in ArcGIS Desktop.
Using ArcGIS Pro
1. Highlight the Ontario Web Raster Service layer in the table of contents. Select the “Data” tab on the ribbon and click the “Explore Raster Items” button. The “Raster Item Explorer” pane will open.
[image: Image showing how to open the raster item explorer window in ArcGIS Pro]
[bookmark: _Toc108094615][bookmark: _Toc110868512]Figure 61: Open the Raster Item Explorer in ArcGIS Pro.
Select a raster tile and click the “Inspect” tab in the Raster Item Explorer pane. The tile metadata will appear.
[image: Image showing how to view the metadata information for a raster tile in ArcGIS Pro]
[bookmark: _Toc108094616][bookmark: _Toc110868513]Figure 62: View tile metadata in ArcGIS Pro.
Using QGIS
Tile level metadata cannot be accessed in QGIS because WCS layers don’t contain raster attribute tables. 
Return to Table of Contents.



[bookmark: _Toc118965026]Performing Change Detection
The Ontario Imagery Data Service contains multitemporal imagery for some areas. Change detection can be performed on these areas to identify pixels that have changed due to long-term, seasonal, or abrupt changes. There are many different methods that could be used to perform change detection. The following steps outline one possible method of performing change detection with the Ontario Imagery Data Service. The Raster Function Editor provides a powerful alternative.
Using ArcGIS Desktop
1. Add the Ontario Imagery Data Service to a map document. Right click the layer and open the “Properties…”.
[image: Image showing how to open an image service's layer properties in ArcMap.]
[bookmark: _Toc108094617][bookmark: _Toc110868514]Figure 63: Open the Ontario Web Raster Service Layer Properties in ArcMap.
Select the “Definition Query” tab and write a SQL query to select one of the imagery projects. At the time of writing, there is only one project area with two years of imagery, “COOP2016 and COOP2021”.
[image: Image showing how to create a definition query in ArcMap.]
[bookmark: _Toc108094618][bookmark: _Toc110868515]Figure 64: Create a definition query in ArcMap.
Rename the layer in the table of contents to reflect the definition query.
[image: Image showing the renamed imagery layer in ArcMap.]
[bookmark: _Toc108094619][bookmark: _Toc110868516]Figure 65: Rename the Ontario Web Raster Service in ArcMap.
Repeat steps 1-3 to add imagery from the other project year. 
[image: Image showing two layers in ArcMap.]
[bookmark: _Toc108094620][bookmark: _Toc110868517]Figure 66: Add a second layer with a definition query in ArcMap.
Open the “Image Analysis” window and highlight the two raster layers in the Image Analysis Window. Click the “Difference” tool located in the “Processing” section of the Image Analysis window.
[image: Image showing how to use the difference tool in ArcMap.]
[bookmark: _Toc108094621][bookmark: _Toc110868518]Figure 67: Use the difference tool in ArcMap.
The difference raster will be added to the table of contents as a layer. Enable “DRA” with the “Display” section of the “Image Analysis” window.
[image: Image showing the results of the difference tool in ArcMap.]
[bookmark: _Toc108094622][bookmark: _Toc110868519]Figure 68: View the difference raster in ArcMap.
Using ArcGIS Pro
1. Add the Ontario Imagery Data Service to a map document. Right click the layer and open the “Properties…”.
[image: Image showing how to open an image service's layer properties in ArcGIS Pro.]
[bookmark: _Toc108094623][bookmark: _Toc110868520]Figure 69: Open the Ontario Web Raster Service Layer Properties in ArcGIS Pro.
Select the “Definition Query” section and create a new definition query to select one of the imagery projects. At the time of writing, there is only one project area with two years of imagery, “COOP2016 and COOP2021”.
[image: Image showing how to create a definition query in ArcGIS Pro.]
[bookmark: _Toc108094624][bookmark: _Toc110868521]Figure 70: Create a definition query in ArcGIS Pro.
Rename the layer in the table of contents to reflect the definition query.
[image: Image showing the renamed layer in ArcGIS Pro.]
[bookmark: _Toc108094625][bookmark: _Toc110868522]Figure 71: Rename the Ontario Web Raster Service in ArcGIS Pro.
Repeat steps 1-3 to add imagery from the other project year. 
[image: Image showing two layers in ArcMap.]
[bookmark: _Toc108094626][bookmark: _Toc110868523]Figure 72: Add a second layer with a definition query in ArcGIS Pro.
Highlight the two raster layers in the table of contents. Select the “Imagery” tab on the ribbon menu, click the “Process” drop down tool and run the “Difference” tool.
[image: Image showing how to use the difference tool in ArcGIS Pro.]
[bookmark: _Toc108094627][bookmark: _Toc110868524]Figure 73: Use the difference tool in ArcGIS Pro.
The difference raster will be added to the table of contents as a layer. Highlight the new layer in the table of contents, select the “Appearance” tab on the ribbon menu and enable “DRA”.
[image: Image showing the difference tool results in ArcGIS Pro.]
[bookmark: _Toc108094628][bookmark: _Toc110868525]Figure 74: View the difference raster in ArcGIS Pro.
Using QGIS
QGIS does not support attribute table querying of ArcGIS Image Server services. This limitation restricts QGIS’s ability to perform change analysis using the multitemporal imagery provided via the Ontario Imagery Data Service. 
Return to Table of Contents.



[bookmark: _Toc118965027]Building Histograms and Reclassification
Some raster functions in ArcMap and ArcGIS Pro require histogram statistics. Calculating these statistics on large datasets can be very time consuming. A more efficient way to estimate and build the histogram is to resample the original raster to a new raster with reduced sampling size, build the histogram on the resampled raster, and import the histogram to the original raster.
How To: Estimate and build histograms for large raster datasets in ArcMap (esri.com)
Remap function—ArcGIS Pro | Documentation
Using ArcGIS Desktop
1. Add the desired dataset to a map document and open the “Image Analysis” window.
[image: An image showing how to open the image analysis pane in Arcmap.]
[bookmark: _Toc110868526]Figure 75: Open the Image Analysis pane in ArcMap.
Open the function template editor in the Processing pane of the Image Analysis window.
[image: An image showing how to open the function template editor in ArcMap.]
[bookmark: _Toc110868527]Figure 76: Open the function template editor in ArcMap.
Right click the Identify function, highlight insert function and select the Resample function.
[image: An image showing how to create a Resample function in ArcMap.]
[bookmark: _Toc110868528]Figure 77: Open the Resample function in ArcMap
In the Raster Function Properties dialog box, set the original pixel size for Input cell size, and a larger pixel size for Output cell size to reduce the resolution of the output raster. Click OK to apply the function. This step generates a new layer that is a resampled raster with coarser spatial resolution.
[image: An image showing how to apply the resample function in ArcMap.]
[bookmark: _Toc110868529]Figure 78: Apply the Resample function in ArcMap
Right-click the new layer in the Table Of Contents and open the Layer Properties. Select the Symbology tab and Classified symbology. Click Yes on the Compute Histogram warning pop-up window.
[image: An image showing how to compute the histogram for the resampled layer in arcmap.]
[bookmark: _Toc110868530]Figure 79: Compute the histogram for the resampled layer in ArcMap
Save the resampled raster layer with histogram built as a layer file by right-clicking the layer > Save As Layer File.
[image: An image showing how to save the layer definition in arcmap.]
[bookmark: _Toc110868531]Figure 80: Save the layer definition in ArcMap

In the Image Analysis window, select the original raster dataset and add a raster function. Right-click Identity Function > Insert Function > Statistics and Histogram Function.
[image: An image of adding the Statistics and Histogram Function in ArcMap.]
[bookmark: _Toc110868532]Figure 81: Create a Statistics and Histogram function on the original raster in ArcMap
In the Raster Function Properties dialog box, for the Import Statistics and Histogram from File option, browse to the layer file saved in Step 8, and click OK.
[image: An image showing how to define raster statistics in Arcmap.]
[bookmark: _Toc110868533]Figure 82: Define the raster statistics using the previously defined layer file in ArcMap
Click OK in the Function Template Editor to apply the function.
Right click the newly created layer in the table of contents and open the Layer Properties. Select the Symbology tab and Classified symbology.
[image: An image showing how to apply the classified symbology in arcmap.]
[bookmark: _Toc110868534]Figure 83: Apply the classified symbology in ArcMap
Using ArcGIS Pro
1. Add the desired dataset to a map document. Select the “Imagery” tab on the ribbon toolbar and click the “Raster Functions” button.
[image: An image showing how to open the raster functions pane in ArcGIS Pro.]
[bookmark: _Toc110868535]Figure 84: Open the Raster Functions pane in ArcGIS Pro.
Search for the “Resample” function. Set the raster service for Raster, set the original pixel size for Input cell size, and a larger pixel size for Output cell size to reduce the resolution of the output raster. Click “Create new layer” to apply the function. This step generates a new layer that is a resampled raster with coarser spatial resolution.
[image: An image showing how to apply the resample function in ArcGIS Pro.]
[bookmark: _Toc110868536]Figure 85: Apply the Resample function in ArcGIS Pro
Select the new layer in the Table Of Contents. Select the Raster Layer tab on the Ribbon menu, select the Symbology drop down menu and select Classify symbology. Click Yes on the Compute Histogram warning pop-up window.
[image: An image showing how to compute the histogram for the resampled layer in ArcGIS Pro.]
[bookmark: _Toc110868537]Figure 86: Compute the histogram for the resampled layer in ArcGIS Pro
Save the resampled raster layer with histogram built as a layer file by right-clicking the layer in the table of contents > Sharing > Save as Layer File.
[image: An image showing how to save the layer definition in ArcGIS Pro.]
[bookmark: _Toc110868538]Figure 87: Save the layer definition in ArcGIS Pro
Select the original raster dataset in the table of contents. Select the Raster Layer tab on the ribbon menu and click the Symbology button to open the symbology pane. Click the “hamburger” icon in the symbology pane and select “Import from layer file”.
[image: An image showing how to import the classified symbology layer file in ArcGIS Pro.]
[bookmark: _Toc110868539]Figure 88: Import the classified symbology in ArcGIS Pro
Select the layer file created above and click OK. The raster layer will now be symbolized with the previously created Classified symbology.
[image: An image showing the applied classified symbology in ArcGIS Pro.]
[bookmark: _Toc110868540]Figure 89: Apply the classified symbology in ArcGIS Pro
Using QGIS
QGIS doesn’t support the ability to build raster histogram statistics and perform reclassification on-the-fly with ArcGIS Image Services. If you’d like to perform reclassification using QGIS, it is recommended that you export the raster needed for the study area and reclassify the local copy of the raster.
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